
The science behind the report:

Harness the power of the  
HP ZBook Firefly 14 G10 A Mobile 
Workstation and work unplugged 
for a full business day—or more

This document describes what we tested, how we tested, and what we found. To learn how these facts translate 
into real-world benefits, read the report Harness the power of the HP ZBook Firefly 14 G10 A Mobile Workstation 
and work unplugged for a full business day—or more.

We concluded our hands-on testing on June 15, 2023. During testing, we determined the appropriate hardware 
and software configurations and applied updates as they became available. The results in this report reflect 
configurations that we finalized on April 19, 2023 or earlier. Unavoidably, these configurations may not represent 
the latest versions available when this report appears.

Our results
To learn more about how we have calculated the wins in this report, go to http://facts.pt/calculating-and-highlighting-wins.  
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Table 1: Results of our testing.

HP ZBook Firefly G10 A  
14” Mobile Workstation

Dell™ Precision™ 3480  
14” Workstation

PassMark PerformanceTest 11.0

Overall PassMark rating (higher is better) 7,835.6 7,121.3

CPU Mark sub-score (higher is better) 28,501.2 27,391.4

2D Graphics Mark sub-score (higher is better) 864.5 455.6

3D Graphics Mark sub-score (higher is better) 7,169.2 7,301.3

Memory Mark sub-score (higher is better) 3,083.6 3,257.2

Disk Mark sub-score (higher is better) 44,467.3 23,756.1

Cinebench R23

Multi-core score (higher is better) 14,594 12,076
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HP ZBook Firefly G10 A  
14” Mobile Workstation

Dell™ Precision™ 3480  
14” Workstation

Cinebench R23 sustained performance and thermal testing

Multi-core sustained performance score - average (higher is better) 14,371 11,694

Ambient Room temperature (degrees Fahrenheit) (lower is better) 70.5 70.5

Keyboard deck  temperature (degrees Fahrenheit) (lower is better) 115.3 120.6

Underside of chassis temperature (degrees Fahrenheit) (lower is better) 126.5 147.6

MobileMark 2018 - “best power efficiency” mode 200 nits 200 nits

Battery life (hours:min) (higher is better) 10:54 8:33

Normalized system efficiency (minutes per WHr) (higher is better) 12.824 9.500

Performance qualification score (higher is better) 965 525

Productivity sub-score (higher is better) 839 452

Creativity sub-score (higher is better) 1,183 641

Web browsing sub-score (higher is better) 905 500

MobileMark 2018 - “best performance” mode 200 nits 200 nits

Battery life (hours:min) (higher is better) 8:57 6:52

Normalized system efficiency (minutes per WHr) (higher is better) 10.529 7.630

Performance qualification score (higher is better) 1,409 1,531

Productivity sub-score (higher is better) 1,269 1,339

Creativity sub-score (higher is better) 1,502 1,555

Web browsing sub-score (higher is better) 1,468 1,723

MobileMark 25 - “best power efficiency” mode 250 nits 250 nits

Battery life (hours:min) (higher is better) 10:30 7:58

Normalized system efficiency (minutes per WHr) (higher is better) 12.353 8.852

DC performance (higher is better) 797 427

MobileMark 25 index (higher is better) 502 204

Productivity sub-score (higher is better) 646 362

Creativity sub-score (higher is better) 1,020 516

Responsiveness sub-score (higher is better) 771 399
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HP ZBook Firefly G10 A  
14” Mobile Workstation

Dell™ Precision™ 3480  
14” Workstation

MobileMark 25 - “best performance” mode 250 nits 250 nits

Battery life (hours:min) (higher is better) 8:57 6:15

Normalized system efficiency (minutes per WHr) (higher is better) 10.529 6.944

DC performance (higher is better) 1,086 1,268

MobileMark 25 index (higher is better) 583 475

Productivity sub-score (higher is better) 979 1,255

Creativity sub-score (higher is better) 1,257 1,401

Responsiveness sub-score (higher is better) 948 962

Acoustic testing with Cinebench R23

Ambient room - median average (dBA) (lower is better) 23.2 23.2

System idle - median average (dBA) (lower is better) 23.5 23.7

System under Cinebench R23 load - median average (dBA) (lower is better) 34.4 35.9

Difference from room while idle (dBA) (lower is better) 0.3 0.5

Difference from room while under Cinebench R23 load (dBA)  
(lower is better) 11.2 12.7

Figure 1: Acoustic testing results, in A-weighted decibels. Lower is better. Source: Principled Technologies.
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System configuration information
Table 2: Detailed information on the systems we tested.

System configuration information
HP ZBook Firefly G10 A 14”  
Mobile Workstation

Dell Precision 3480 14” Workstation

Processor

Vendor AMD Intel®

Model number Ryzen™ 7 PRO 7840HS Core™ i7-1370P vPro

Core frequency (GHz) 3.8 – 5.1 1.9 – 5.2

Number of cores 8 14

Number of threads 16 20

Cache (MB) 16 24

Memory

Amount (GB) 32GB (2x 16GB) 32GB (2x 16GB)

Type DDR5-5600 DDR5-4800

Speed (MHz) 5,600 4,800

Graphics #1

Vendor AMD Intel

Model number Radeon™ 780M Graphics Iris Xe® Graphics

Driver version v.31.0.14003.38003 v.31.0.101.4502

Graphics #2

Vendor N/A NVIDIA®

Model number N/A RTX™ A500

Driver version N/A v.31.0.15.2852 
(02/05/2023)

Storage

Model Number SK Hynix PC801 Micron 2450

Amount (GB) 512GB 512GB

Type NVMe® PCle® Gen 4 x4 NVMe PCle Gen 4 x4

Connectivity/expansion

Wireless internet MediaTek WiFi 6E MT7922 Intel Wi-Fi 6E AX211

Bluetooth 5.3 5.2

USB

1x USB Type-A

1x USB Type-A (charging)

2x Thunderbolt 4 Type-C (USB Power 
Delivery, DisplayPort, HP Sleep and 
Charge)

2x USB 3.2 Gen 1 (power enabled)

2x Thunderbolt 4 Type-C

Video 1x HDMI 2.0b 1x HDMI 2.0
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System configuration information
HP ZBook Firefly G10 A 14”  
Mobile Workstation

Dell Precision 3480 14” Workstation

Battery

Type Lithium-polymer Lithium-polymer

Rated capacity (WHr) 51 54

Cells 3 3

Display

Size (in.) 14 14

Type WUXGA (250 nits) FHD (250 nits)

Resolution 1920 x 1200 1920 x 1080

Touchscreen No No

Operating system

Vendor Windows Windows

Name 11 Pro 11 Pro

Build number or version 22H2 22621.2134 22H2 22621.2134

BIOS

BIOS name and version HP V82 Ver. 01.03.01 Dell 1.6.0

Dimensions

Height (in.) 0.78 0.75 – 0.83

Width (in.) 12.42 12.65

Depth (in.) 8.8 8.4

Weight (lbs.) 3.46 3.57
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How we tested

Setting up the systems

Creating and updating the OEM Windows 11 Pro Image
1. Boot the system.
2. Follow the on-screen instructions to complete installation, using the default selections when appropriate.
3. In the bottom right corner, click the battery icon, and adjust the Windows Power mode (plugged in) to Best Performance.
4. Unplug the system, and in the bottom right corner, click the battery icon, and adjust the Windows Power mode (on battery) to Best 

Performance. Plug the system back in.
5. Set DPI scaling to 100%, and set Screen and Sleep options to Never:

• Right-click the desktop and select Display settings.

• Under the Scale and layout section, for the Change the size of text, apps, and other items option, select 100%.

• From the left column, select Power & Sleep.

• For all power options listed under Screen and Sleep, select Never.

6. Disable User Account Control notifications:

• Select Windows Start, type UAC, and press the Enter key.

• Move the slider control to Never notify, and click OK.

7. Run Windows Update, and install all updates available.
8. Launch the Windows Store app, and install all Store app updates.
9. Launch each vendor proprietary utility app installed on each system, and update any drivers or BIOS files. 

• For Dell, run the Dell Command Update utility. 

• For HP, run the HP Support Assistant utility.

10. Verify the date and time are correct, and synchronize the system clock with the time server.
11. Disable Automatic Windows Update:

• Right-click the Windows Start button.

• Select Computer Management.

• Select Services and Applications.

• Select Services.

• Scroll down, and double-click Windows Update.

• Click Stop.

• From the Startup type drop-down menu, select Disabled.

Capturing an image
1. Connect an external HDD to the system.
2. Click Windows Menu button, and type Control Panel in the search bar. Click Control PanelSystem and SecurityBackup and 

Restore (Windows 7)Create a system image.
3. Verify that the external HDD is selected as the save drive, and click Next.
4. Verify that all drives are selected to back up, and click Next.
5. Click Start backup.
6. At Do you want to create a system repair disc, select No, and close the dialogs.

Restoring an image
1. Connect an external HDD to the system.
2. Press and hold the Shift key while Restarting the system.
3. Select Troubleshoot.
4. Select Advanced options.
5. Select See more recovery options.
6. Select System image recovery.
7. Select the User account.
8. Enter the system password, and click Continue.
9. At the Restore system files and settings screen, select Next.
10. Verify that the external HDD is selected, and click Next.
11. Once the recovery has completed, click Finish.
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Measuring performance with PassMark PerformanceTest

Setting up the test
1. Install PassMark PerformanceTest.
2. Download PassMark PerformanceTest from https://www.passmark.com/products/performancetest/download.php.
3. To begin the installation, press Install.
4. Select Accept to accept the license agreement, and press Next.
5. After the installation is complete, deselect Launch Performance Test, and press Finish. 

Running the test
1. Boot the system. 
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. To launch PassMark PerformanceTest, press the PassMark PerformanceTest icon.
7. To start the benchmark, press Run Benchmark.
8. When the test completes, record the results.
9. Repeat steps 6 through 8 two more times.
10. Report the median of the three runs.

Measuring performance with Cinebench R23

Setting up the test
1. Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

Running the test
1. Boot the system. 
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. Launch Cinebench.
7. Select FileAdvanced benchmark.
8. Set the Minimum Test Duration to Off.
9. Select either CPU (Multi Core) or CPU (Single Core), and click Start.
10. Record the result.
11. Wait 10 minutes before re-running.
12. Repeat steps 7 through 11 twice more, and record the median result.
13. 

Measuring thermals and sustained performance with Cinebench R23

These tests require the following:

• A FLIR E6xt Infrared Camera

• Cinebench R23

Running the test
1. Boot the system. 
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. Launch Cinebench R23.
7. Select FileAdvanced benchmark.
8. Verify that the Minimum Test Duration is set to the default 10 minutes (Test Throttling).
9. Select CPU (Multi Core) and click Start.
10. Record the performance results for the next five back-to-back 10-minute iterations and at the end of each run, note the ambient room 

temperature, and take a skin temperature photo with the FLIR E6xt infrared Camera of the top and bottom. Report the hottest spots.
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Measuring acoustics 

Measuring acoustics while idle
1. Boot the system.
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. Start the Extech SDL600 Sound Level Meter/Datalogger and allow the laptop to run at idle for 20 minutes.
7. At the end of the 20 minutes, stop the Extech SDL600 and record the average Idle (dB).
8. Shut down the laptop.
9. Repeat steps 1-8 two more times.

Measuring acoustics while running Cinebench R23

Setting up the test

1. Purchase and download the Cinebench R23 benchmark from https://www.maxon.net/en/downloads/cinebench-r23-downloads.
2. Launch Cinebench R23.
3. Select File->Advanced benchmark.
4. Select File->Preferences, and change the Custom Minimum Test Duration to 20 minutes, and click OK.
5. Exit Cinebench.

Running the test

1. Boot the system.
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. Launch Cinebench R23.
7. In the Minimum Test Duration field, select Custom (20 minutes).
8. In Cinebench R23, simultaneously start the Extech SDL600 Sound Level Meter/Datalogger and click CPU (Multi Core) Start.
9. At the end of the Cinebench R23 run, stop the Extech SDL600, and record the average sound level (dB) while running Cinebench R23.
10. Shut down the laptop for 40 minutes, and let it return to room temperature.
11. Repeat steps 1 through 10 two more times.

Measuring battery life with MobileMark 2018

This test requires an X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts
MobileMark 2018 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs 
before we installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 2018 installs the following applications, which its test scripts employ:

Productivity

• Adobe Acrobat® Pro DC

• AutoIT 3.3.14.2

• Google Chrome 

• Microsoft Excel 2016

• Microsoft OneNote 2016

• Microsoft Outlook 2016 

• Microsoft PowerPoint 2016

• Microsoft Word 2016

• Windows Zip
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Creativity

• Adobe Photoshop CC

• Adobe Lightroom Classic CC

• CyberLink PowerDirector® 2015 

Web Browsing

• Google Chrome

• Microsoft Movies & TV

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts. 
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs 
MobileMark 2018 uses—before we installed the benchmark.

Adjusting display brightness and power settings
The brightness of a system’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2018, you ensure 
the brightness of the notebook’s monitor is greater than or equal to 200 nits in the center of a completely white screen while the notebook 
is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards Association 
(www.vesa.org).

We complied with this standard for all our tests by setting each notebook PC’s brightness as close to 200 nits as we could without going 
below that level. We used the following procedure before we started each test. Note: This procedure assumes we began with the system 
plugged into the power supply.

1. To create a completely blank, white screen, open Microsoft Paint by clicking Start→All Programs→ Accessories→Paint.
2. Press Ctrl+W to open the Resize and Skew dialog.
3. Under Horizontal and Vertical, enter 200, and click OK.
4. Click the View tab.
5. To view a white screen, click Full screen.
6. To allow the screen to warm, wait 45 minutes.
7. Unplug the system from the power supply, and measure the display’s brightness using a luminance meter in the center of the screen. 

(We used an X-Rite - i1Display Plus colorimeter.)
8. If the reading is below or significantly greater than 200 nits, adjust the screen brightness to as close to 200 nits as you can without going 

under, and retest:

a. Click the Windows Start button.
b. In the Windows Start search box, type display settings
c. Adjust the slider to change the Display brightness to the correct percentage that produces no less than 200 nits.

9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another reading.

Using the MobileMark built-in configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

• Disables User Account Control (UAC)

• Set DPI Scaling to 100%

• Disables Low Battery Actions

• Disables Network Proxies

• Disables System Sleep and Hibernate

• Disables Windows Update

• Enables Windows Search
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Level 2 - Recommended

• Create BAPCo power scheme

• Set Power Plan Type to Balanced

• Set CPU Adaptive Mode

• Disables Battery Saver Dimming

• Verifies Battery Saver Threshold

• Disables Disk Defrag

• Disables Windows Error Reporting

• Disables Windows Lock Screen

• Disables Windows Pop-ups

• Disables Screen Saver and Monitor Timeout

• Disables Windows Sidebar/Gadgets

• Disables Desktop Slideshow

• Disables Windows Defender

• Disables Windows Firewall

• Set Font Smoothing

Level 3 - Optional

• Disables Hard Disk Timeout

• Disables System Restore

• Ignores Laptop Lid Close

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark2018 User Guide (http://bapco.com/
wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf), which runs the benchmark using the Required and 
Recommended options.

Setting up the performance-qualified battery life test
1. On a separate PC, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/

i1profiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.
2. On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected 

to the internet.
3. On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

• Select Windows Start, type Battery saver, and press the Enter key.

• Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle the button to Off.

4. On the system under test, verify that the volume is set to 50%.
5. On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

• Launch AMD Software.

• Click the Settings gear icon.

• Select the Display tab, and disable Vari-Bright.

6. Verify that the screen brightness is set to no less than 200 nits.
7. Install MobileMark 2018 with the default options.
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Running the performance-qualified battery life test
1. Boot the system. 
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. Launch MobileMark 2018.
7. Click on the Settings gear icon.
8. Verify that Conditioning Run is enabled.
9. Enter a name for the benchmark run.
10. To return to the main menu, click the Back button.
11. Click Run Benchmark.
12. When prompted, unplug the AC power adapter. The test will begin immediately.

The benchmark is complete when the system under test has fully depleted its battery and is no longer operational when running 
on battery power.

We executed the MobileMark 2018 benchmark three times on the system and took the median battery life score run as the representative 
performance score result for that test.

Measuring battery life with MobileMark 25

This test requires an X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts
MobileMark 25 is not compatible with any virus-scanning software, so we uninstalled any such software present on the systems before we 
installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 25 installs the following applications, which its test scripts employ:

Productivity

• Adobe Acrobat Pro DC

• Audacity

• Corel WinZip 24.0 Enterprise

• Google Chrome 

• Microsoft Excel 2019 Professional Plus VL

• Microsoft Outlook 2019 Professional Plus VL 

• Microsoft PowerPoint 2019 Professional Plus VL

• Microsoft Word 2019 Professional Plus VL

• Shotcut

Creativity

• Adobe Photoshop CC

• Adobe Lightroom Classic CC

• Adobe Premiere Pro CC

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts. 
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs 
MobileMark 25 uses—before we installed the benchmark.
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Using the MobileMark built-in configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

• Disables User Account Control (UAC)

• Set DPI Scaling to 100%

• Disables Low Battery Actions

• Disables Network Proxies

• Disables System Sleep and Hibernate

• Disables Windows Update

• Enables Windows Search

• Disables WinSAT

Level 2 - Recommended

• Create BAPCo power scheme

• Set Power Plan Type to Balanced

• Set CPU Adaptive Mode

• Disables Battery Saver Dimming

• Verifies Battery Saver Threshold

• Disables Disk Defrag

• Disables Windows Error Reporting

• Disables Windows Lock Screen

• Disables Screen Saver and Monitor Timeout

• Disables Windows Security Center

• Set Font Smoothing

Level 3 - Optional

• Disables Hard Disk Timeout

• Disables System Restore

• Ignores Laptop Lid Close

• Enables Dark Mode

• No Wait for OpenMP Threads

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark25 User Guide (https://bapco.com/wp-content/
uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf), which runs the benchmark using the Required and Recommended options.

Setting up the performance-qualified battery life test
1. On a separate system, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/

i1profiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.
2. On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected 

to the internet.
3. On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

• Select Windows Start, type Battery saver, and press the Enter key.

• Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle the button to Off.

4. On the system under test, verify that the volume is set to 50%.
5. On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

• Launch AMD Software.

• Click the Settings gear icon.

• Select the Display tab, and disable Vari-Bright.

6. Verify the system is no less than 250 nits.
7. On the system under test, install MobileMark 25 with the default options.

November 2023 | 12Harness the power of the HP ZBook Firefly 14 G10 A Mobile Workstation and work unplugged for a full business day—or more 

https://bapco.com/wp-content/uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf
https://bapco.com/wp-content/uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf
https://www.xrite.com/categories/formulation-and-quality-assurance-software/i1profiler
https://www.xrite.com/categories/formulation-and-quality-assurance-software/i1profiler
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Running the performance-qualified battery life test
1. Boot the system. 
2. Select Windows Start.
3. Type cmd, and press Ctrl+Shift+Enter.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5. After the command completes, wait 5 minutes before running the test.
6. Launch MobileMark 25.
7. Click Run Benchmark.
8. Click the Brightness Profiler button.

• Allow the white screen to warm up for 30 minutes. After 30 minutes, click Skip.

• At the Panel Dark Luminance pop-up, to use the value that is queried from the display, select Yes.

• Place the X-Rite - i1Display Plus colorimeter in the outlined spot on the screen.

• On the system under test, toggle the F1 button to turn off the test overlay.

• On the colorimeter system, start i1Profiler program, and select Advanced.

• Click Display, and click Profiling.

• Next to Luminance, click the drop-down menu and select Measure.

• In the drop-down menu that appears below, select Paper in booth.

• In the box with the image that says, “Place your paper in the light booth,” scroll down so that you can click the Measure button.

• On the system under test, adjust the slider until the Target White luminance is met on the colorimeter system.

• Once the correct Target White luminance is met on the test PC, click Done.

9. Click Continue.
10. The test will begin immediately. When prompted, unplug the AC power adapter. 

The benchmark is complete when the system under test has fully depleted its battery and is no longer operational when running 
on battery power.

We executed the MobileMark 25 benchmark three times on the system and took the median battery life score run as the representative 
performance score result for that test.

Read the report at https://facts/pt/l9L4hFp
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